
Web Publishing with Mozilla Composer 

Web Publishing with Mozilla Composer 

This course explains how to use Mozilla Composer to quickly produce and publish a 
basic Web page. Mozilla Composer provides a point and click way to create Web pages: 
it works like word-processing software and allows you to add links and images as well as 
text. With Composer, you can revise an existing web page to suit your needs or start from 
a blank page to create your own. Since Composer creates a HyperText Markup Language 
(HTML) file that you publish on the World Wide Web, it is not necessary to know 
HTML codes to publish to the Web. This method is only one way to create a Web page. 

Class objectives 

By the end of this class, you will be able to do the following: 

• Identify the basic steps required to publish a Web document. 
• Prepare your Copland directory to receive Web files (you only do this once). 
• Create a basic Web page using Composer and preview it in Navigator. 
• Transfer files to your Copland directory. 
• Identify the basic elements of a Web page and their associated codes. 

Note: This class is designed to be used at the Pearson Hall Training Center (Room 116) 
on PCs running Windows XP. The exercises may not work identically elsewhere. 

UNIX computer account 

To transfer files to a Web directory, you must have an account on a Web server. At the 
University of Delaware, the Web server is on the central UNIX server. All University of 
Delaware faculty, staff and students can obtain an account on the central UNIX server. 
This account is a privilege granted to you by the University. You must act responsibly 
when you use it, or you can lose this privilege. If you are uncertain about the proper use 
of computing resources, read a copy of the Policy for Responsible Computing on the 
University’s web site <www.udel.edu/ecce/policy.approved.html>. 

Resources for learning more about WWW and HTML 

There are many good online resources with information about preparing documents for 
the Web, including tutorials, style guides, editors, and other tools. You can find many of 
them listed at <http://www.udel.edu/ideacenter/>. 
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Publishing Web Pages on the World Wide Web 

udel.edu 
(Copland); 
for personal pages 

www.udel.edu 
for publishing
 official pages 

Create your 
Web page Send a copy 

to a web 
server. 

University documents). Be sure that your files are protected so that 

To publish a Web page, first create the page on your computer using 
a Web page editor or HTML code. Send a copy of the completed file 
to the Web server (Copland for personal pages, www for official 

others can view them. The documents are then ready for viewing. 
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Introduction 

The World Wide Web (WWW) is a system that enables you to make information easily 
available to anyone anywhere who has a WWW browser (e.g., Mozilla, Netscape, 
Internet Explorer, Safari, Lynx). You make your information available by placing it in a 
file that is called a “page” or a “document” and is specially formatted using HTML. This 
language consists of an easy-to-learn set of codes that you include with the information 
you wish to publish. You then make the HTML file available to a WWW server. 

In this course, you will publish a Web page using Mozilla Composer—a Web page editor 
that lets you design a document in a word-processing environment and creates the HTML 
file for you. Composer has a menu bar with pull-down options and Composition and 
Formatting toolbars with buttons for creating your document. 

Publishing files on the World Wide Web 

When you publish Web pages, be sure you have an understanding of the overall process. 
For each new page you publish, you will perform the following steps: 

1.	 Create the page on your computer using a Web page editor or using HTML codes. 
The file you create remains on your computer’s hard drive. 

2.	 Copy the file to the Web server (Copland) using the SSH File Transfer Program so 
that others can view it. 

3.	 Once the file is uploaded to the Web server, you must set protection codes to allow 
others to view your Web page. 

Note: If you set up your public_html directory for this class (see instructions on the 
following page), the protection codes will not need to be changed after you transfer 
your files. When you publish in official University directories, you will need to learn 
more about setting protection codes. Information is available on the web at 
<http://www.udel.edu/webstart/protections.html>. 

4. 	 Once your page is in place and available, you must either give others its address or 
have the page linked to from another page. 

UNIX file structure 

The UNIX file system is a hierarchy of directories and sub-directories starting from a 
single directory called root which is represented by a / (slash). Imagine this as similar to 
the root system of a plant or as an inverted tree structure. In turn, the directories and sub­
directories point to files—the information in your document. Your public_html directory 
is a sub-directory of your home directory. This is where you will publish the Web page 
files that you create in this class. 

In the following exercise, you will create a sub-directory of your UNIX home directory 
named public_html. 
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Exercise 1: Preparing your directory 

1.	 In the Applications folder, double-click the SSH Secure Shell Client icon. In the 
dialog box that appears, type your UDelNet ID and click Connect. If you see a 
question about saving your “host key” to the local database, answer No. In the 
next dailog box, type your password and click OK. 

2.	 Create your public_html directory and make it executable and readable by 
others: At the UNIX % prompt, type 

source /www/htdocs/learn/usered/html-setup


Note: there is a space after the word “source.” 

3.	 Type 

exit


at the UNIX (%) prompt. 

4.	 From the File menu, select 

Exit


to quit the SSH Secure Shell Client. 

Using Composer to create a Web page 

In the following exercises, you will create a Web page using the buttons and menu 
options available in Composer. 

Exercise 2: Beginning your Web page 

Note: When you create your Web page, you add or change text in the file using the 
mouse and keyboard. When you start typing, that text becomes part of your Web 
page. If you want to delete text, highlight the text and press the DELETE or BACK­
SPACE keys. If you want to replace text, highlight it and type the new text. You can 
also copy text from other applications and paste the text into Composer. 

1.	 Open Mozilla Composer. 

From the Start menu, select All Programs and then the Mozilla 1.7 folder. 
Click Mozilla 1.7 Navigator. When the Navigator window appears, select the 
Window menu, then choose Composer. 

continued on next page 
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continued from previous page 

2.	 From the Composer View menu, select Show/Hide and make sure the following 
toolbars are checked: Composition, Format, Edit Mode and Status Bar. 

3.	 From the Composer Edit menu, select Preferences. Click the plus sign next to 
Composer and select Toolbars. Make sure every box in the window is checked and 
then click OK. 

4.	 To begin your page, from the drop-down list on the Format 
toolbar, choose Heading 1. Type 

Publishing Web Pages


then press the ENTER key. Notice that the drop-down list returns to Body Text. 

5.	 From the drop-down list on the Format toolbar, choose Paragraph. Type the 
following paragraph. Do not indent or press the ENTER key at the end of each line. 

To publish a Web page, first create an HTML file on

your computer. Then, send a copy of the file to the

Web server (Copland or www). Be sure to keep the

information on your Web page current and keep your

audience in mind when designing your page.


Press the ENTER key. 

6. Highlight the words your audience then click the Italics button on the Format 
toolbar. 

7.	 Click below paragraph you just added and from the drop-down list on the Format 
toolbar, choose Paragraph. Type the following line: 

The ideal Web document:


then press the ENTER key. 

8.	 Click the Bulleted List button and type the following items (press the ENTER 
key at the end of each line). Note that each time you press the ENTER key, 
Composer inserts a bullet. 

Is attractively designed.

Communicates effectively.

Leads easily to related information.


Be sure to press the ENTER key at the end of the third line.

 9. Click the Bulleted List button to turn off the option. 

continued on next page 

Information Technologies        5 



Web Publishing with Mozilla Composer 

continued from previous page 

10. Press the ENTER key, then choose Heading 2 from the drop-down list on the 
Format toolbar. Type 

Where do I publish my Web page?


and press the ENTER key. 

11. From the drop-down list on the Format toolbar, choose Paragraph. Type the 
following paragraph (do not press the ENTER key at the end of each line): 

When you publish a Web page on a UD server,

its location depends on the type of document it is.

Personal pages are published in your public_html

directory on Copland; official University

documents are published on www.


Press the ENTER key. 

12. Click the Insert Table button , then complete the Insert Table Properties box 
by including the following information: 

• Enter 2 for the number of rows and columns. 
• Change the Width to 50 percent of the window. 
• Leave the Border set at 1pixel. 

Click OK. 

13. When the table has been inserted on your page, click the Table button again and 
from the Caption drop-down box, select Above Table. 

14. Click OK. Notice that the top selection handle is now well above the table. The area 
between the top of the table and the handle is where you will type the caption. 

15. Type the following information in the table. Type the caption first. Then click in the 
upper-left table cell and type the text. Use the Tab key to move among table cells. As 
you type, the cell size adjusts automatically to accommodate text.

 What is the URL of My Web Page?

 Copland http://udel.edu/~your_username/filename.html
 www http://www.udel.edu/directory_path/filename.html

 You can modify the appearance of a table in the Table Properties box. Click in any 
cell in the table, choose the Format menu, then select Table Cell Properties. Click 
a tab—Table or Cell—to reformat all or part of the table. 

continued on next page 
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continued from previous page 

16. Click the Spell button  on the Composition toolbar. Correct any spelling 
errors, if necessary. Click the Close button when you finish. 

17. Click the Save button 	 . When the Page Title box appears, type a descriptive title, 
such as Publishing Documents on the World Wide Web. You will then see the Save 
As dialog box. Click the down-arrow next to the Save In: box. Click (C:), then 
double-click Scratch. Name the file webpage.html and click Save. 

18. Click OK. 

Previewing your Web page 

Before you transfer your document to the Web server, you can preview (browse) it in 
Navigator. This is especially useful for checking special formatting, links and images you 
have included. 

Exercise 3: Previewing your file 

1.	 Click the Browse button on the Composition toolbar. If you have not saved 
the file recently, Composer will prompt you to do so. 

2.	 When you finish previewing your Web page, click the X in the upper-right corner of 
the Navigator window. Remember, you cannot edit your document in the browser 
window. 

Naming your home page 

Most Web sites contain multiple files that are linked to a “home page” (your main or 
introductory page). The most efficient way to handle a home page is to give it the name 

index.html 

The advantage to naming your home page index.html is that most browsers will display 
the index.html file if no specific HTML filename is given. Thus, people searching for 
your personal Web page on the “udel.edu” Web server only have to know your UDelNet 
ID to be able to find your files, and people on the University’s central Web server would 
only have to know the name of the directory in which your files reside. They do not have 
to remember an HTML filename to get to your information. 
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Creating links 

The process for creating links is the same whether you are linking to a UD Web page or 
to Web pages around the world. First you must know the URL (Uniform Resource 
Locator) or address for the page you wish to link to. In the next exercise, you will create 
two links: one to the UD Home Page and one that will generate a mail window addressed 
to your e-mail account. 

Exercise 4: Creating links 

1.	 Position the cursor below the table. If Paragraph is not showing in the drop-down 
list on the Format toolbar, click to select it. 

2.	 Click the Link button on the Composition toolbar. 

3.	 In the Enter text to display for the link box, type 

UD Home Page


4.	 In the Link Location box, type 

http://www.udel.edu/


Click OK. 

5.	 Position the cursor below the UD Home Page link and from the drop-down list on 
the Format toolbar, choose Paragraph. 

6.	 Click the Link button on the Composition toolbar. 

7.	 In the Enter text to display for the link box, type 

Questions?


In the Link Location box, type 

mailto:your_UDelNet_ID@udel.edu


This link provides anyone viewing your page with a way to send you an e-mail 
message. Note: Because of security issues, mailto links will not work in UD 
computing sites. 

8.	 Click OK. 

9.	 Browse your page and check that your link works correctly. 
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Including graphics 

Before you include a graphic, make sure that you are not violating any copyright laws. 
You may use the graphics available from the UD IdeaCenter 
<www.udel.edu/ideacenter/>, although there are some restrictions for student Web pages. 
Guidelines for students can be found in the “Policy for Student Use of Computer 
Resources for Home Pages” <www.udel.edu/webstart/stuorg/student.resource.html>. 
Information on fair use guidelines for educational multimedia can be found at 
<www.udel.edu/present/instructions/copyright/>. 

In the next exercise, you will add an image found at <www.udel.edu/learn/cool.gif>. 
Then you will createa button and link it to return to the UD Home page. 

Exercise 5: Adding graphics 

1.	 To insert a graphic, first click the mouse where you want the image to appear. Then, 
click the Image icon . 

2.	 In the Image Location box, type the URL of the image: 

http://www.udel.edu/learn/cool.gif


Note: If you are adding an image from your hard disk to your Web page, be sure to 
save your Web page before adding the image. Then in the Image Properties box, 
check the box beside URL is relative to page location. This is necessary to make 
the references to the images correct once you copy your Web page and its images to 
the Web server. 

3.	 Provide alternative text for those using non-graphical browsers. Click the radio 
button next to Alternate Text and type the following in the box: 

cool character


Click OK. 

4.	 You can also create linked images and buttons to enhance your page. Move your 
cursor in front of the UD Home Page link. Click the Image icon then type the 
following URL in the Image Location box: 

http://www.udel.edu/images/Logos/hm.gif


5.	 Click the radio button next to Alternate Text and type the following in the box: 

University of Delaware logo


6.	 Click the Link tab. Type the URL for the UD home page: (http://www.udel.edu). 

continued on next page 
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continued from previous page 

7.	 Click the Appearance tab. Set (or reset) the solid border to 0 pixels. Click OK. 

8. Browse your page. (You will be asked to save the page first.) 

Adding features to your page 

Composer provides buttons and menu options for adding features to your Web page. For 
instance, you can select a background color from the Page Colors and Background 
window. It is important to think of the impact of the color or feature on the audience and 
to remember that not all browsers display colors in exactly the same way. 

You should include the month and date you last updated your file at the bottom of your 
page and be sure to keep the information in your document current. 

Exercise 6: Using the features available in Composer 

1.	 Experiment with adding a background color to your page and changing the text color. 
To alter the color scheme of your page, from the Format menu, choose Page Colors 
and Background. 

2.	 In the Page Colors and Background window, click the radio button next to Use 
Custom Colors. Click one of the color buttons (Normal text, Link text, Active link 
text, Visited link text or Background), then select a color. Click OK. 

3.	 Type the following URL in the Background Image box: 

http://www.udel.edu/learn/background.jpg


4.	 Click OK. 

When you use an image for your background, the image overrides any background 
color you have set. If for some reason the background image can not be displayed, 
the background color will appear. Note: Color preferences (and other elements) can 
be set by by the user to override those set in a Web page. 

5.	 Position the cursor on the line below the “Cool” image. Click the H. Line button on 
the Composition toolbar to add a horizontal rule. 

6.	 Press the ENTER key. 

7.	 Position the cursor on the line below the horizontal line. Add the phrase 

Last updated September 2004


at the bottom of your page. 

continued on next page 
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continued from previous page 

8.	 Click the Save button. 

9.	 Browse your page. 

Viewing the HTML source 

All Web pages are constructed with HTML codes. When you create a Web page using 
Mozilla Composer, you don’t normally see these codes. Composer creates them for you. 
Sometimes, it is useful to view the HTML codes. Since HTML codes are the “source” of 
the web page that you see, this is often referred to as “viewing the source.” In the next 
exercise, you will view the source of your Web page in Composer. 

Exercise 7: Viewing your HTML source 

1.	 From the tabs at the bottom of the Composer page, choose <HTML> Source. 

2.	 The <HTML> Source (HTML file) appears in the window. Notice the information 
in the brackets (<>). These are HTML tags. Appendix B describes the most common . 
HTML tags and their uses. 

3.	 Click the Nomal tab at the bottom of the page to return to the Composer editing 
window. 

Validating your page’s HTML 

An important step before you transfer any pages to the Web server is to make sure the 
HTML for your page contains no errors. This will be especially important when you are 
transferring multiple-page Web sites with links among the pages. In the next exercise, 
you will use the Composer Validation tool to make sure your HTML is valid. 

Exercise 8: Validating HTML 

1.	 From the Composer Tools menu, select Validate HTML. This brings up a new 
Navigator page for the World Wide Web Consortium’s (W3C) Markup Validation 
Service. 

2.	 Click the Browse button and locate your webpage.html file. Click Open. 

3.	 When the pathname for the file appears in the Validate page’s File box, click the 
Validate this file button. If the HTML is valid, you will receive a message saying 
that the file was checked and is valid. If not, you will receive a list of errors with 
explanations of what the error means. 
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Publishing your page 

When you save your Web page in Composer, it writes the HTML source code to a file 
with the extension .html. When you are satisfied with the appearance of your page, you 
are ready to publish it. You now have to transfer a copy of the new files to your 
public_html directory on Copland. When you save your file, Composer also saves the 
graphics (.gif or .jpg file) in the same location. When you transfer your page, you also 
need to transfer any graphics files you have added to your page. Remember that millions 
of people can view the page once it is on the Web. 

Using the Secure Shell File Transfer Program 

The Secure Shell File Transfer window allows you to manage files on your computer and 
in your UD server directory, including Web pages, graphics, documents, and more. With 
the file transfer program you will be able to:

 * View any directory or file on your computer and on the server.
 * Create, rename, move, and delete folders and files on your computer or within your

 server directory.
 * Transfer any file or folder between your computer and your directory on the server.
 * Change the permissions of files in your server directory.

How to open the SSH File Transfer window 

Exercise 9: Opening the SSH File Transfer window 

The SSH File Transfer window allows you to transfer files from your desktop computer 
to a remote computer and from a remote computer to your desktop computer. You can 
transfer text files, graphics files, and files created by applications such as Microsoft 
Word. 

1.	 In the Applications folder, double-click the SSH Secure Shell Client icon. In the 
dialog box that appears, type your UDelNet ID and click Connect. If you see a 
question about saving your “host key” to the local database, answer No. In the next 
dailog box, type your password and click OK. 

2.	 On the SSH toolbar, click the File Transfer Window button:

 You will see a window like the one on the next page: 

continued on next page 
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continued from previous page 

Local Name 
The Local Name pane on the left side of the window lists the files and folders on 
your computer and enables navigation very similar to that in Windows Explorer. 
Files can be dragged from your computer (Local Name) to the server (Remote Name) 
or from the server to your computer. 

Remote Name 
This area displays directories and files in your home directory on the UNIX server. 
You may also view other server directories and files as needed. 

File Transfer Status and History 
The status of each uploaded or downloaded file will appear on the Transfer tab at the 
bottom of the window. All actions are displayed in an exportable history list. The 
Queue tab displays files ready for upload or download. 

How to transfer files using the SSH File Transfer program 

Exercise 10: Transferring files to your Web directory 

1.	 In the Remote Name window pane, change to the public_html directory by double-
clicking the directory name (folder). 

2. 	 Select the format of the file you want to transfer: 

continued on next page 
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continued from previous page 

•	 Click (ASCII) for files that contain only text or program source 

code. Examples are files that end with .html, .htm, and .txt. 

•	 Click (Binary) for files that contain formatting codes such as files produced 

by word processing, spreadsheet, or graphics programs. Examples are Microsoft 
Word, Microsoft Excel, .gif, and .jpg files. 

•	 Click (Auto) if you are unsure of the format of the files. 

3.	 From the Scratch folder in the Local Name window pane, select the webpage.html 
file by clicking the file name. 

4.	 Drag the highlighted file to the public_html directory in the right window pane. 

Note: To transfer files from the server directory to your local computer, follow the 
directions above, dragging the selected files to the left window pane. 

How to delete files or folders using the SSH File Transfer program 

•	 Select a file or folder you wish to delete from either the Local Name or Remote 
Name window pane. 

•	 From the Operation menu, select Delete to delete the file or folder. Alternatively, 
you can click the red X on the File bar. 

•	 A Confirm Delete dialog box appears, allowing you to confirm if you really want to 
delete the selected files or folders. Click Yes to delete the selected items or Cancel to 
keep them. 

Once you have transferred your Composer page to the Copland Web server, you will 
want to browse it in Mozilla Navigator to see how it will look to the world. 

Exercise 11: Browsing your published home page 

1.	 Open Navigator by selecting it from the Window menu in the Composer window. 

2.	 In the Location box, type the URL of your new home page. Note: Do not include 
www or public_html as part of the address. 

http://udel.edu/~UDelNet_ID/filename


To change your Web page, you can edit the copy on your local computer and then repeat 
the publishing steps using SSH File Transfer. If you change personal computers, you can 
open the file in Mozilla and choose Edit Page from the Mozilla Navigator File menu to 
edit the page in Composer. 
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Starting with another page as a template 

It is easy to use Mozilla Composer to copy a Web page you like and then use the HTML 
as a basis for developing your own page. You can use University of Delaware template 
files (found at http://www.udel.edu/ideacenter/) or a page that already exists on the Web. 
Follow these steps to use another page as the model for your own page. 

1.	 While viewing the page you want to use as a template, from the Navigator File menu, 
select Edit Page. 

2.	 Modify the content of the page using word processing techniques or the menu 
options and format buttons. For example, if you want to delete text, highlight the text 
and press the DELETE or BACKSPACE key. If you want to replace text, highlight 
the text and type the new text. Or add a table using the Table button. 

3.	 To insert a graphic, first click the mouse at the location where you want the image to 
appear. Then either choose Image from the Insert pull-down menu or click the 
Image button. Supply the name of the graphic file and provide alternative text for 
those using nongraphical browsers. 

4.	 To preview your page, click the Browse button on the Composition toolbar. Before 
you can preview the document, you must save a copy on your local system. Com­
poser will prompt you to save the document. 

5.	 Follow the directions in this document to transfer the page to your public_html 
directory. 

You can find some templates to help you begin Web design at 

http://www.udel.edu/ideacenter/ 
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Appendix A–Converting a Microsoft Word document to HTML 

You can use Microsoft Word to convert existing documents to HTML format. Use Save 
as Web Page from the Microsoft Word File menu; then use Secure Shell File Transfer to 
move your documents to the Web. Remember, layout differences may exist after you 
convert a document. 

1.	  Open Word. 

2.	 When the application opens, from the File menu, choose Open. Then, from the list of 
available documents, double-click the document you wish to convert. 

Note: When the document opens, familiarize yourself with the layout. The converted 
document will not look exactly like the original. 

3.	 From the File menu, choose Save as Web Page. 

When you save your file in Word 2003, be sure to complete the following steps 
before uploading the files. 

a.	 In the Save As dialog box, click the Tools icon and choose Web Options.... 

b.	 On the Browsers tab, select Microsoft Internet Explorer 4.0, Netscape 
Navigator 4.0, or later from the Target Browsers pull-down list. Then select 
Disable features not supported by these browsers. 

(Note: If the box is checked that says “Save new Web Pages as Single File Web 
Pages,” uncheck it.) 

c.	 Click OK. 

The file name should appear in the File Name box. If the Save As Type box 
does not say Web Page (*.htm, *.html), use the pull-down arrow to select it. 

4.	 Click Save. 

Note: When you convert a document to HTML format, you retain the original 
document as a separate file. The new HTML file has the same file name but a 
different file extension (.htm). 

5.	 When the conversion is complete, the converted file (filename.htm) appears in the 
window. View the HTML source code file by clicking the View menu and selecting 
HTML Source. 

6.	 If you have graphics in your document, scroll through the HTML source code to find 
the reference to the image. Word names images consecutively (Image1.gif, 
Image2.gif, etc.). When you upload your page, be sure to include these image files. 

7.	 Return to your file by clicking the X in the HTML Source window. 
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8.	 You can modify the HTML file using the Microsoft Word formatting buttons and 
menu options and the Web toolbar options (insert hyperlink, insert image). When you 
are satisfied with the appearance of your page, be sure to save it. 

9.	 Close your document by selecting the File menu then choosing Close. Click the 
Close button (the X in the upper-right corner) to close Word. 

10. Open your HTML file in a WWW browser to see how it will appear. 

11. Next, 	you must transfer your files to your Web directory using the SSH File Transfer 
program. 

12. Once you have uploaded your page, view it in Mozilla to see how it will appear to the 
world. 

13. Open Mozilla Navigator. In the Location box, type the address (URL) of your page. 
If you published in your public_html directory, the URL will be 
http://udel.edu/~your_UDelNet_ID/filename.htm. If you published in an official 
University directory, the URL will be 
http://www.udel.edu/directory_path/ filename.htm. 
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Appendix B—Viewing the elements of your Web page 

Hypertext markup language (HTML) is the language used to create documents for the 
World Wide Web. To view the source of a Composer document, choose the HTML 
Source menu item from the View menu. Tags are used to label the elements of a Web 
page. Tags come in pairs, one before and one after the text you want to act on. 

<tag name>text</tag name> 

Each web page must have certain elements; some of them are listed below. For example, 
the code for creating boldface text is <b>; so, to make a word boldface, the code would 
be <b>word</b>. The following list describes some commonly used html tags. 

<html> </html>	 Placed at the very beginning and end of a document. 

<head> </head>	 Placed after the <html> tag; The “head” contains 
general information about the document. Use 
</head> tag at the close of the “head” section. 

<title> </title>	 The title for your entire Web page. It appears in the blue 
area at the top of the browser and the code is placed 
between the head tags. 

<body> </body>	 Placed after the </head> tag and before the final 
</html> tag. Contains the information that 
appears on your web page in a browser window. 

<h#> </h#>	 There are 6 levels of headings, <h1> to <h6>. 
<h1> often uses the same text as the title. Headings 
are placed around text for organizational purposes: 

<h1>heading level 1</h1> most important level

<h2>heading level 2</h2>

<h3>heading level 3</h3>

<h4>heading level 4</h4>

<h5>heading level 5</h5>

<h6>heading level 6</h6>  least important level


<pre> </pre>	 Indicates that you want the text between these 
tags to display as preformatted text—exactly as 
you designed it. 

<b> </b> Bold

<i> </i> Italic

<tt> </tt> Typewriter spacing (monospaced)

<blockquote> </blockquote> Sets off a long quotation
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<ul> Unordered, bulleted list (without numbers)
 <li></li> List item
 <li></li> 

</ul> 

<ul type=x> </ul> x can be “disc” (round solid bullet), “circle” 
(round hollow bullet) or “square” (square hollow 
bullet). 

<ol> Ordered list (with numbers)
 <li></li> List item
 <li></li> 
</ol> 

<dl> Definition list (a term followed by a definition)
 <dt></dt> Definition term
 <dd></dd> Definition
 <dt></dt>
 <dd></dd> 
</dl> 

<table></table> Begin and end a table. You must add a “border” 
attribute to have a border displayed (table border=1). 

<tr></tr> Define a table row. 
<th></th> Label the rows or columns or both. 
<td></td> Include data in the table. 
<caption></caption> Give the table a caption. 

<p></p> Insert a paragraph break. 

<hr /> Insert a horizontal rule. 

<br /> Insert a line break. 

<a href=“filename”>text</a> A hypertext reference for creating a link. 

<img src=“graphic name”> The code for including graphics in a Web page. 
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